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DEVICES DEMO MANUAL DC2515B
LTC6810-1
6-Channel Buttery-Stack Monitor
with Daisy-Chdadin Interface
DESCRIPTION

Demonstration circuit 25158 features the LTC®6810-1, a
6-channel battery-stack monitor. Multiple boards can be
linked through a 2-wire isolated serial interface (isoSPI™)
to monitor a long series of cells in a stack. The DC2515B
demo board also features reversible isoSPI enabling a
redundant communication path. The PCB, components,
and DuraClik connectors are optimized for Low EMI
Susceptibility and Emissions.

The DC2515B can communicate to a PC by connecting
a DC2792B dual master isoSPI together with DC2026

Linduino® One. The DC2026 must be loaded with the
appropriate program (called a sketch) to control the bat-
tery stack monitor IC and receive data through a USB
serial port. The DC2026C provides a standard SPI inter-
face which can be translated to isoSPI and then con-
nected to a DC2515B isoSPI port (J4 or J5 connector).
The DC2792B companion board provides two SPI-isoSP!I
channels for reversible operation.

Design files for this circuit board are available.

All registered trademarks and trademarks are the property of their respective owners.

PEBFOBmm'ICE Summﬂﬁ\' Specifications are at T = 25°C

PARAMETER MIN TYP MAX UNITS
V* Supply Voltage 5.0 20 27.5 V
V* 1o C6 Voltage -0.3 V
C0/S0 Voltage 0 5 V
VReg Supply Voltage 45 5 55 v
VRery 1t Reference Voltage, No Load 3.1 3.2 3.3 V
Vrer 2nd Reference Voltage, 5k Load to V™ 2.994 3 3.006 v
Vgias IBIAS Voltage, READY/ACTIVE State 1.9 2.0 2.1 V
Cpyy Input Range 0 V
Cell Count
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DEMO MANUAL DC2515B

HARDWARE SETUP

Wiring J1 Connector

The DC2515B demo board connector pinout is critical;
correct wiring must be followed to avoid the risk of dam-
aging the DC2515B demo board.

When connected to a battery-stack, power for the
DC2515B is provided by the cell group being monitored.
To connect the cell group, separate the screw-terminal
block section from the J1 connector. Then, insert the cell-
voltage connections or resistors into the screw-terminal
clamping contacts. These connections provide the power
and input stimulus for the battery-stack monitor IC.

Cell-voltages are wired to J1 starting from position 4
(most negative potential of the group). Please refer-
ence the appropriate demo board J1 connector pinout
in Table 1.

Alternatively, resistors can be used to simulate battery
cell-voltages. 100Q 2W or equivalent resistors are recom-
mended because 100€2 (or lower values) typically will not
induce measurement errors and the 2W (or greater rating)
will keep the resistor temperatures low preventing power
dissipation damage.

DC2515B 6 Resistor Connection

Carefully connect six 100Q resistors onto the screw-
terminal block between each Cpyy input clamping con-
tact from position 4 to position 10 as shown in Table 1,
DC2515B J1 pinout and Figure 1. Provide a stack-equiva-
lent power supply connection to position 10 (positive) and
position 4 (negative). The power supply may be adjusted
to provide the desired nominal cell-voltage (ex. 19.8V will
be 3.3V per cell).

Table 1. DC2515B J1 Pinout

J1PIN Cpiy INPUT
1 NC
2 NC
3 NC
4 CON-
5 C1
6 C2
7 c3
8 c4
9 c5
10 C6
11 NC
12 NC
13 NC
14 NC
15 NC
16 NC
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Figure 1. Resistor Divider String
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DEMO MANUAL DC2515B

PDC25158 SERIAL INTERFACE OPTIONS

The isoSPI is the only communication option to DC2515B.
Due to the custom EMI optimized isoSPI cable with
DuraClik connectors, it's highly recommended to use
DC2792B dual master isoSPI demo board or equivalent
for easy plug-and-play operation. The DC2792B dual
master isoSPI demo board can be connected as a typi-
cal single-ended isoSPI bus master or to both ends of
a reversible configuration with two isoSPI bus masters.
Refer to demo manual DC2792B for usage details.

DC2792B to DC2515B Typical isoSPI Connection

Atypical isoSPI connection begins with the isoSPI Master
connected to the first (or bottom) DC2515B. Additional
DC2515B boards can be daisy-chained onto the isoSP!I
bus. Communication begins from the first (or bottom)
DC2515B then to the next upper DC2515B and, finally, to
the last (or top) DC2515B.

Figure 2 shows the following connections for two boards
on a stack interfaced to a PC:

1. Connect a USB cable from the PC USB port to the
DC2026 J5 connector.

2. Connectthe DC2026tothe DC2792B dual masterisoSPI
demo board.

a. Connect a 14-pin ribbon cable from the DC2026 J1
header to the DC2792B J1 header.

3. Connect the DC2792B to the DC2515B. This DC2515B
is the first (or bottom) board of the stack.

| DC2026 DC27928_ MAN
: 1 B -
] - AUX
| 15 o 13
J1

i DC2515B i1

a. Gonnect a 2-wire twisted-pair patch cable from the
DC2792B J2 MAIN DuraClik connectorto the bottom
DC2515B J4 isoSPI A DuraClik connector.

CAUTION! The 2-wire twisted-pair patch cable with
the DuraClik end plugs have Tmm thick center locking
tabs on the wiring side that must be pressed down to
release from the DuraClik receptacles. Failure to do
S0 may damage the cable and prevent board-to-board
isoSPI communication.

4. Connect or daisy-chain the DGC2515B to another
DG2515B in isoSPI mode. This DC2515B is the last
(or top) board of a two-board stack. More DC2515B
upper boards can be daisy-chained together in the
same manner.

a. Gonnect a 2-wire twisted-pair patch cable from the
hottom DC2515B J5 isoSPI B DuraClik connector to
the next upper ortop DC2515B J4 isoSPI A DuraClik
connector.

5. CAUTION! Prevent damage to the DC2515B. Refer to
Table 1 and confirm that the cell-voltage connections
to the screw-terminal block matches the DG2515B J1
pinout.

a. Plugthescrew-terminal blocksintothe J1 cell-voltage
connectors.

6. Refertothe Software Setup section ofthis demo manual
to properly setup the PC with the Arduino IDE software
to allow communication to the DC2515B boards.

DC2515B

isoSPIA

ok '
14

"

isoSPIB
15

Figure 2. DC2792B Typical isoSPI Connection to the Bottom DC2515B in a Two-Board DC2515B Stack

Rev. 0



https://www.analog.com/DC2515B?doc=DC2515B.pdf

DEMO MANUAL DC2515B

PC25158 SERIAL INTERFACE OPTIONS

DC2792B to DC2515B Reverse isoSPI Connection

A reverse isoSPI connection begins with the isoSPI
Master connected to the last (or top) DC2515B. Additional
DC2515B boards can be daisy-chained onto the iso-
SPI bus. Communication begins from the last (or top)
DC2515B then to the next lower DC2515B and, finally, to
the first (or bottom) DC2515B.

Figure 3 shows the following connections for two boards
on a stack interfaced to a PC:

1. Connect a USB cable from the PC USB port to the
DC2026 J5 connector.

2. Connectthe DC2026tothe DC2792B dual masterisoSPI
demo board.

a. Gonnect a 14-pin ribbon cable from the DC2026 J1
header to the DG2792B J1 header.

3. Connect the DC2792B to the DC2515B in isoSPI
mode. This DC2515B is the last (or top) board of a
two-board stack.

a. Connect a 2-wire twisted-pair patch cable from the
DC2792B J2 MAIN DuraClik connector to the top
DC2515B J5 isoSPI B DuraClik connector.

CAUTION! The 2-wire twisted-pair patch cable with
the DuraClik end plugs have Tmm thick center locking
tabs on the wiring side that must be pressed down to

| pcao26
u

DC2792B :";A'”
by I | -
B - AUX
| 5 u 13
1

d5— to——

release from the DuraClik receptacles. Failure to do
so may damage the cable and prevent board-to-board
iSoSPI communication.

4. Connect or daisy-chain the DC2515B to another
DC2515B inisoSPI mode. This DC2515B is the first (or
bottom) board of a two-board stack. More DC2515B
lower boards can be daisy-chained togetherinthe same
manner.

a. Connect a 2-wire twisted-pair patch cable from the
top DC2515B J4 isoSPI A DuraClik connector to the
next lower or hottom DC2515B J5isoSPI B DuraClik
connector.

5. CAUTION! Prevent damage to the DC2515B. Refer to
Table 1 and confirm that the cell-voltage connections
to the screw-terminal block matches the DG2515B J1
pinout.

a. Plugthescrew-terminal blocksintothe J1 cell-voltage
connectors.

6. Refertothe Software Setup section ofthis demo manual
to properly setup the PC with the Arduino IDE software
to allow communication to the DG2515B boards.

DC2792B to DC2515 Redundant isoSPI Connection

A redundant isoSPI connection begins with the primary
(or main) isoSPI Master connected to the first (or hot-
tom) DC2515B and has a backup auxiliary (or aux) isoSPI

il wr ST wr
‘81d50s1 ¥ Idsost ‘g1dsost ¥ idsest
‘ 10 ‘ 10
8515200 o 8515200 o

Figure 3. DC2792B Reverse isoSPI Connection to the Top DC2515B in a Two-Board DC2515B Stack
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PC25158 SERIAL INTERFACE OPTIONS

Master connected to the last (or top) DC2515B. Additional
DC2515B boards can be daisy-chained between the two
isoSPI masters on the isoSPI bus. Primary (or main) com-

S0 may damage the cable and prevent board-to-board
isSoSPI communication.

munication begins from the first (or bottom) DC2515B 4 ggggﬁ%% gi‘;g}cgﬂgeﬂ}%g%%%ﬁ%;?s ?Rgtlgg
;[hen B%g‘;%?tﬁ?pgr [:(02515E.3|land,f|nally, to the Iast.(or (or top) board of a two-board stack. More DC2515B
0p) DG25158. The backup auxiliary (or aux) communica upper boards can be daisy-chained together in the
tion begins in the reverse direction to provide coverage same manner
when a possible isoSPI daisy-chain break occurs. '

. . . a. Connect a 2-wire twisted-pair patch cable from the
Figure 4 shows the following connections for two boards hottom DC2515B J5 isoSPI B DuraClik connector to
on a stack interfaced to a PG: the next upper or top DC2515B J4 isoSPI A DuraClik
1. Connect a USB cable from the PC USB port to the connector.

DC2026 J5 connector. 5. Connect the DC2792B auxiliary (or aux) isoSPI Master
2. Connectthe DC2026tothe DC2792B dual masterisoSPI to the last (or top) DC2515B board of the stack.
demo board. a. Connect a 2-wire twisted-pair patch cable from the
a. Connect a 14-pin ribbon cable from the DC2026 J1 DC2792B J3 AUX DuraClik connector to the top
header to the DC2792B J1 header. DC2515B J5 isoSPI B DuraClik connector.
3. Connectthe DC2792B primary (or main)isoSPImaster 6. CAUTION! Prevent damage to the DG2515B. Refer to
to the first (or bottom) DC2515B board of the stack. Table 1 and confirm that the cell-voltage connections
a. Connect a 2-wire twisted-pair patch cable from the tq thetscrew-termmal block matches the DC25158 J1
DC2792B J2 MAIN DuraClik connector to the bottom pinout.
DC2515B J4 isoSPI A DuraClik connector. a. Plugthescrew-terminal blocksintotheJ1 cell-voltage
CAUTION! The 2-wire twisted-pair patch cable with connectors.
the DuraClik end plugs have Tmm thick center locking 7. Refertothe Software Setup section of this demo manual
tabs on the wiring side that must be pressed down to to properly setup the PC with the Arduino IDE software
release from the DuraClik receptacles. Failure to do to allow communication to the DC2515B boards.
— I — I
i DC2515B i DC2515B

&

isoSPIA isoSPIB
14 15

| DC2026 DC2792B  MAN
: n B -
B - AUX
I 15 . 13
11

Figure 4. DC2792B Redundant isoSPI Connections to the Bottom and Top DC2515B in a Two-Board DC2515B Stack
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SOFTWARE SETUP

The DG2515B can be controlled with the DC2026 Linduino One board together with DC2792B dual isoSPI Master or
equivalent isoSPI transceiver. The DC2026 is part of the Arduino compatible Linduino platform that provides example
code that will demonstrate how to control the multicell battery-stack monitor ICs. Compared to most Arduino compat-
ible microcontroller boards, the DC2026 offers conveniences such as an isolated USB connection to the PC, built-in
SPIMISO line pull-up to properly interface with the battery stack monitor IC open drain SDO, and an easy ribbon cable
connection for SPI communication through the DG2792B 14-pin QuikEval™ J1 connector.

Arduino IDE Setup
1. Download then install the Arduino IDE onto the PC. Detailed instructions can be found under the quick start tab.

2. Setthe Arduino IDE to open BMS Sketchbooks. From within the Arduino IDE, click on File menu select Preferences.

Then under Sketchhook location: select Browse and locate the path to the extracted LTSketchhook.zip file that was
downloaded (see Figure 5).

Preferences X
Settings  Network

Sketchbook location:

C:\EXAMPLEY TSketchbook

Editor language: System Default « | (requires restart of Arduino)
Editor font size: 13
Interface scale: Automatic | 100 % (requires restart of Arduino)

Show verbose output during: [ compilation [ ] upload
Compiler warnings: None ~
Display line numbers
[] Enable Code Folding
Verify code after upload
[ Use external editor
Check for updates on startup
Update sketch files to new extension on save {.pde -= .ino)
Save when verifying or uploading
Additional Boards Manager URLs: ['m|

C:\Users\EGonzale\AppDataLocal\Arduino 15Ypreferences. bt

oK Cancel

Figure 5. Sketchbook Location Path
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DEMO MANUAL DC2515B

SOFTWARE SETUP

. Close then re-open the Arduino IDE to enable the use of the Sketchbook Location that was previously set.

. Select the correct COM port to allow communication to DG2026 through USB. Under the Tools menu, select Port
— Select the highest number COMxx with the v check mark symbol. There may be more than one option; DC2026
is usually the highest COM port number. The PC screenshots (Figure 6) used in this example show the DC2026
connected to COM6.

-

&9 sketch_jullla | Ardui

no 181

sketch_jullia

1 wvoid setup
2| Jf put o

6 void loop|(
7 /f put o

File Edit Sketch Help

Auto Format Ctrl+T
Archive Sketch

Fix Encoding & Reload

Ctrl+Shift+M
Ctrl+Shift+L

Serial Monitor

Serial Plotter
WiFi101 Firmware Updater

Board: "Arduino/Genuino Uno” >
Port: "COMG" )
Get Board Info

Programmer: "AVRISP mkil" 4

Burn Bootloader

Figure 6. Selecting Correct COM

Serial ports
v COM6

5. Select the correct Arduino compatible microcontroller board. Under the Tools menu, select Board — Arduino/
Genuino Uno with the @ black dot symbol (see Figure 7).

9 sketch_jullia | Arduino 1.81

-

File Edit Sketch Help

Auto Format

Ctrl+T
h

Boards Manager...

Arduino AVR Boards

Archive Sketc
sketch_jull1a Fix Enceding & Reload
1 vold setup Serial Monitor
= Dtz Serial Plotter
411 WIFi101 Firmware Updater
g void loop( Board: "Arduino/Genuino Uno"
DO MOBEEE port mCOME"
9|} Get Board Info Arduino Yin

Programmer: "AVRISP mkll"

Burn Bootloader

Arduino/Genuine Uno

Arduino Duemilanove or Diecimila

Ardiima Mann

Figure 7. Selecting Compatible Microcontroller Board
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SOFTWARE SETUP

6. Open one of the programs or sketches associated with the DC2515B. In this example LTC6810 sketch will be opened.
Under the File menu, select Sketchbook — Part Number — 6000 — 6810 — DC2515 (see Figure 8).

@ sketch_jullla | Arduino 1.8.1
File Edit Sketch Tools Help

MNew Ctrl+M
Open... Ctrl+0
Open Recent >

Sketchbook j Active Learning ¥
Examples 1 Example Designs  *
Close Ctrl+W Part Number : 1000 -4
Save Ctrl+5 User Contributed 2000 >
Save As... Ctrl+Shift+5 Utilities 1 3000 ¥
¥ T T T 4000 >
Page Setup  Ctrl+Shift+P
5000 >
Print Ctrl+P
6000 : 6115 >
Preferences  Ctrl+ Comma 9000 b 6602 >
a 3 >
Quit Ctrl+Q ADI-Parts 6603
6803 >
6804 >

6810 DC2515

Figure 8. Selecting the LTC6810 Sketch
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SOFTWARE SETUP

7. Upload the DC2515 sketch onto the DC2026 by clicking on the Upload button on the top left corner. When this

process is completed there will be a Done Uploading message on the bottom left corner (see Figure 9).

& DC2515 | Arduino 1.1

File Edit Sketch Tools Help

DC2515

-

O

X

Figure 9. Uploading DC2515 Sketch

8. Open the Arduino Serial Monitor (Figure 10) tool. Click on the Serial Monitor button on the top right corner then

the Serial Monitor window will open and show on the top left corner the COMxx used.

D@ﬂh

Serial Monitor

Figure 10. Arduino Serial Monitor Tool
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SOFTWARE SETUP

9. Configure the Serial Monitor to allow communication to the DC2026 through USB. On the bottom of the Serial
Monitor window, set the following starting from bottom left to bottom right:

a. Click on the Autoscroll checkbox for the v check mark symbol.

b. Select Both NL & CR on the left dropdown menu.

c. Select 115200 baud on the right dropdown menu.

d. As shown in Figure 11, when configured correctly the DC2515 sketch menu will appear.

& coMs - m] x

Send

Please enter LIC6810 Command
Write and Read Configuration: 1 | Loop Measurements: 12 | Set Discharge: 23

Read Configuration: 2 | Loop Measurements with Data Log output : 13 |Clear Discharge: 24

Start Cell Voltage Conversion: 3 |Clear all ADC Measurement Registers: 14 |Write and Read of PWM : 25

Read Cell Voltages: 4 |Run Mux Self Test: 15 |SPI Communication : 26

Start Aux Voltage Conversion: 35 |Run ADC Jelf Test: 16 |I2C Communication Write to Slave :27
Read Bux Voltages: & |Run Digital Redundancy Test: 17 |12C Communication Read from Slave :28
Start Stat Voltage Conversion: 7 |Open Wire Test for single cell detection: 18 |Reverse ISOSEI : 29

Read Stat Voltages: 8 |0pen Wire Test for multiple cell or two consecutive cells detection: 1%|Read Serial ID : 30

Start Combined Cell Voltage and Cell 0, GPIOZ Conversion: 5|0pen wire for Auxiliary Measurement: 20 |Enable MUTE : 31

Start Cell Voltage and Sum of cells: 10 |Brint PEC Counter: 21 |Disable MUTE : 32

Read S5 Voltage Registers: 11 |Reset PEC Counter: 22 |Set or reset the gpic pins: 33

Print 'm' for menu
Please enter command:

Autoscroll BothML &CR  ~ | 115200 baud -~

Figure 11. DC2515 Sketch Menu
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APPENDIX A: THE SKETCHBOOK CONTENTS

The LTSketchbook will generally contain the following
folders: Libraries, Part Number, Documentation, and
Utilities.

Libraries directory: Contains a subdirectory for each IC in
the sketchbook. Each subdirectory contains a .cpp and .h
file. These files contain all of the constant definitions and
low-level IC command implementations. Porting to a differ-
ent microcontroller requires changes to some library files.

Part Number directory: Contains example control pro-
grams for each IC. Inside the 6000 folder of the Part
Number folder, each 68xx folder is a BMS IC with a
sketch(.ino) file that implements a control program to
evaluate the functionality of the IC. This sketch allows
the user to control the IC through a serial terminal and
make all primary measurements. This sketch also allows

for evaluation of self-test and discharge features of the IC.
Generally, the name of a sketch relates to the IC’s demo
board. For example, the sketch for LTC6804 is DC1942.
ino, for LTC6811 it is DC2259.ino, and for LTC6810 it is
DC2515.ino.

Utilities directory: Contains support programs, includ-
ing a program that emulates a standard Analog Devices
DC590 isolated USB to serial controller.

Documentation directory: Contains hfm/ documentation
for the provided code base. Documentation for all of the
BMS ICs can be accessed by opening the Linduino.html
file, as found in the main sketchbook directory (Figure 12)
and in the Documentation directory.

| [ < | CAEXAMPLE\LTSketchbook - O s
Home Share View 0
ol v » This PC + 0SDisk (C) » EXAMPLE » LTSketchbook ~+ O Search LTSke... 0
#

v LTSketchbook ~ [ Name Date modified Type Size
Active Learning Active Learning 12/6/2019 49 AM  File folder
Documentation Documentation 1 197:49 AM  File folder
Example Designs Example Designs 1 19752 AM  File folder
libraries libraries 12/6/2019 T:53 AM  File folder
Part Number Part Number 12/6/2019 T:53 AM File folder

User Contributed ! 197:53 AM  File folder
User Contributed PRI et
e Utilities 1 197:53 AM File folder
it ¢ Linduino.html 10/24/201912:30 ... HTML File
Intel
MentorGraphics
Microsoft wll= 5
4 items -

Figure 12. Documentation Directory

Rev. 0
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APPENDIX A: THE SKETCHBOOK CONTENTS

What Is A Sketch

A sketch is simply another word for a microcontroller/
Linduino program. The term is generally only used when
referring to Arduino-based programs, as sketches have
several abstractions that remove some of the complex-
ity of a standard microcontroller (MCU) program. All
sketches contain two primary functions, the setup() and
the /oop() function. These are in fact the only functions
that are mandatory in a sketch and are almost always
implemented in some form in a typical MCU program.
The setup() function is run once at power on or after the
MCU is reset. The setup() function generally is used to
initialize the MCU peripheral circuits and to initialize all
of the control variables. The /foop() function is similar to
a main() function that has implemented an infinite loop
inside a standard C program. The code within the /oop()
function is typically where the primary program code is
placed. The code within the /oop() function will repeat
infinitely.

Sketch Modifications

Sketches can be modified to a set of applications spe-
cific requirements. All sketches are written such that the
most common modifications can be made by changing
the variables listed in the /*Setup Variables */table at the
top of the sketch. For reference, example modifications
to a DC2259 (LTC6811) sketch are shown below. These
modifications are applicable to most of the available BMS
ICs in the sketchbook.

Common modifications can be made by changing the
Setup Variables. The most common application changes
are listed below. After the variables are changed, the
sketch will need to be recompiled and uploaded to the
Linduino.

1. To change the number of ICs in the isoSPI network,
change the TOTAL_IC variable. A number between 1

and 4 should be entered. In an application that has 2
devices in the network the modified line will look like
the following.

const uint8 t TOTAL IC = 2;

. Often an application may need to sample data at a rate

fasterthanthe default 500ms (2Hz). To modify the loop/
sample rate the MEASUREMENT_LOOP_TIME variable
should be changed. The loop time must be entered in
milliseconds and should be anumber largerthan 20ms.
To change the loop rate to roughly 10 measurements
a second the loop rate should be changed to 100ms.
The modified line will look like the following.

const uintl6_ t MEASUREMENT LOOP_ TIME = 100;

. Itis possible to modify which measurements fall within

theloop duringthe Loop Measurements command. The
following listare the measurements that can be looped.

const uint8 t MEASURE CELL = ENABLED;
// This is ENABLED or DISABLED
const uint8 t MEASURE AUX = DISABLED;
// This is ENABLED or DISABLED
const uint8 t MEASURE STAT = DISABLED;
//This is ENABLED or DISABLED

By default, only a cell measurement is done, as noted
by MEASURE_CELL = ENABLED. What measurements
are made can be changed by setting what the Measure
fieldis equalto. To Measure Cells and the Status register
but not the AUX register, the variables would be setup
as shown below.

const uint8 t MEASURE CELL = ENABLED;
// This is ENABLED or DISABLED
const uint8 t MEASURE AUX = DISABLED;
// This is ENABLED or DISABLED
const uint8 t MEASURE STAT = ENABLED;
//This is ENABLED or DISABLED

Rev. 0
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APPENDIX A: THE SKETCHBOOK CONTENTS

4. ADC conversion settings can also be modified in the
Setup Variables section. The default setup is to run the
ADC in Normal mode, which has a 7kHz filter code; in this
mode the ADC_OPT bit is disabled. Typical choice for which
cell to convert is ALL. Full ADC conversion programming
requires setting ADC_OPT, ADC_CONVERSION_MODE,
CELL_CH_TO_CONVERT, AUX_CH_TO_CONVERT,
and STAT_CH_TO_CONVERT. These variables are pro-
grammed with constants listed in the LTC68xy_daisy.h
file. For simplicity they are also listed below.

MD 422HZ 1KHZ
MD 27KHZ 14KHZ
MD 7KHZ 3KHZ

MD 26HZ 2KHZ
ADC OPT ENABLED
ADC OPT DISABLED
CELL CH ALL
CELL _CH land?
CELL_CH 2and8
CELL_CH 3and9
CELL _CH 4andl0
CELL CH 5andll
CELL CH 6andl2

Tosetthe ADCto have a 1kHzfilter cornerthe ADC_OPT
and ADC_CONVERSION_MODE variables would be
changed as follows.

ADC OPT = ADC OPT ENABLED;
ADC_CONVERSION MODE = MD_422HZ 1KHZ;
To convert only cells 2 and 8,

CELL CH TO CONVERT = CELL CH 2and8;

. In-another example, the user may wish to change the

undervoltage and overvoltage thresholds. Each number
is based on an LSB of 100pV.

//Under Voltage and Over Voltage Thresholds
const uintl6é t OV _THRESHOLD = 41000;

// Over voltage threshold ADC Code.

// LSB = 0.0001

const uintl6 t UV _THRESHOLD = 30000;

// Under voltage threshold ADC Code.

// LSB = 0.0001

Rev. 0
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ESD Caution
‘2 \ ESD (electrostatic discharge) sensitive device. Charged devices and circuit boards can discharge without detection. Although this product features patented or proprietary protection
circuitry, damage may occur on devices subjected to high energy ESD. Therefore, proper ESD precautions should be taken to avoid performance degradation or loss of functionality.

Legal Terms and Conditions

By using the evaluation board discussed herein (together with any tools, components documentation or support materials, the “Evaluation Board”), you are agreeing to be bound by the terms and
conditions set forth below (“Agreement”) unless you have purchased the Evaluation Board, in which case the Analog Devices Standard Terms and Conditions of Sale shall govern. Do not use the Evaluation
Board until you have read and agreed to the Agreement. Your use of the Evaluation Board shall signify your acceptance of the Agreement. This Agreement is made by and between you (“Customer”)
and Analog Devices, Inc. (“ADI”), with its principal place of business at One Technology Way, Norwood, MA 02062, USA. Subject to the terms and conditions of the Agreement, ADI hereby grants to
Customer a free, limited, personal, temporary, non-exclusive, non-sublicensable, non-transferable license to use the Evaluation Board FOR EVALUATION PURPOSES ONLY. Customer understands and
agrees that the Evaluation Board is provided for the sole and exclusive purpose referenced above, and agrees not to use the Evaluation Board for any other purpose. Furthermore, the license granted
is expressly made subject to the following additional limitations: Customer shall not (i) rent, lease, display, sell, transfer, assign, sublicense, or distribute the Evaluation Board; and (ii) permit any Third
Party to access the Evaluation Board. As used herein, the term “Third Party” includes any entity other than ADI, Customer, their employees, affiliates and in-house consultants. The Evaluation Board is
NOT sold to Customer; all rights not expressly granted herein, including ownership of the Evaluation Board, are reserved by ADI. CONFIDENTIALITY. This Agreement and the Evaluation Board shall all
be considered the confidential and proprietary information of ADI. Customer may not disclose or transfer any portion of the Evaluation Board to any other party for any reason. Upon discontinuation of
use of the Evaluation Board or termination of this Agreement, Customer agrees to promptly return the Evaluation Board to ADI. ADDITIONAL RESTRICTIONS. Customer may not disassemble, decompile
or reverse engineer chips on the Evaluation Board. Customer shall inform ADI of any occurred damages or any modifications or alterations it makes to the Evaluation Board, including but not limited
to soldering or any other activity that affects the material content of the Evaluation Board. Modifications to the Evaluation Board must comply with applicable law, including but not limited to the RoHS
Directive. TERMINATION. ADI may terminate this Agreement at any time upon giving written notice to Customer. Customer agrees to return to ADI the Evaluation Board at that time. LIMITATION OF
LIABILITY. THE EVALUATION BOARD PROVIDED HEREUNDER IS PROVIDED “AS IS” AND ADI MAKES NO WARRANTIES OR REPRESENTATIONS OF ANY KIND WITH RESPECT TO IT. ADI SPECIFICALLY
DISCLAIMS ANY REPRESENTATIONS, ENDORSEMENTS, GUARANTEES, OR WARRANTIES, EXPRESS OR IMPLIED, RELATED TO THE EVALUATION BOARD INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTY OF MERCHANTABILITY, TITLE, FITNESS FOR A PARTICULAR PURPOSE OR NONINFRINGEMENT OF INTELLECTUAL PROPERTY RIGHTS. IN NO EVENT WILL ADI AND ITS
LICENSORS BE LIABLE FOR ANY INCIDENTAL, SPECIAL, INDIRECT, OR CONSEQUENTIAL DAMAGES RESULTING FROM CUSTOMER’S POSSESSION OR USE OF THE EVALUATION BOARD, INCLUDING
BUT NOT LIMITED TO LOST PROFITS, DELAY COSTS, LABOR COSTS OR LOSS OF GOODWILL. ADI'S TOTAL LIABILITY FROM ANY AND ALL CAUSES SHALL BE LIMITED TO THE AMOUNT OF ONE
HUNDRED US DOLLARS ($100.00). EXPORT. Customer agrees that it will not directly or indirectly export the Evaluation Board to another country, and that it will comply with all applicable United States
federal laws and regulations relating to exports. GOVERNING LAW. This Agreement shall be governed by and construed in accordance with the substantive laws of the Commonwealth of Massachusetts
(excluding conflict of law rules). Any legal action regarding this Agreement will be heard in the state or federal courts having jurisdiction in Suffolk County, Massachusetts, and Customer hereby submits
to the personal jurisdiction and venue of such courts. The United Nations Convention on Contracts for the International Sale of Goods shall not apply to this Agreement and is expressly disclaimed.
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